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Trademarks

AnyView, AnyView Browser and AnyView Creator are trademarks of Accountable Software,
(Arpelligo, Inc.)

Microsoft Dynamics is a trademark of Microsoft Corporation in the United States and/or other

countries.

Other company or product names mentioned may be trademarks or registered
trademarks of their respective holders.
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Documentation Files

When AnyView Browser or AnyView Creator are installed, several Documentation files are installed,
Links to these files are installed in Start -> Programs -> Accountable Software — AnyView.

Whats New in AnyView (2018).pdf — A summary of the newest features in AnyView.

AnyView Browser (2018).pdf — Description of Installation and use of AnyView Browser.

AnyView Creator (2018).pdf -- Description of Installation and use of AnyView Creator.

AnyView Upgrade (2018).pdf — Steps for upgrading to the latest AnyView Build or Version

AnyView Tutorial.chm — Examples of real-world use of AnyView features.

Installing AnyView Creator

The installation of AnyView Creator is three-step process:

1. Install AnyView Creator code files.
2. Include the new code into Great Plains

3. Initialize AnyView Tables and Stored Procedures

Important Setup Information
It is highly recommended that you download the latest version of AnyView
from our web site prior to installation.

1. Install AnyView code files.

Insert the Accountable Software CD into the CD-ROM drive or launch the application
downloaded from our website.

The setup program should start as soon as you insert the CD into the drive. If it does not
launch automatically, then it may be started manually by selecting Start » Run from the
Windows Taskbar and selecting the application cDSeTUP on the CD.

If using the website download, find the file that was downloaded (EX: AnyView Creator (2018)
Build 120.exe ) , and double click it to run the setup.

The Main InstallShield installation window opens.

Click NEXT >.

Wait while InstallShield extracts the files needed for the installation.

The installation program begins with the AnyView Setup window.

Click NEXT >.

Review the license agreement, and confirm your acceptance to the terms described within.

Click YEs.

Review the important installation information. Be sure to follow all of the recommended setup steps.

Click NEXT >.
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On the SELECT TYPE window, choose the desired setup type.

AnyView — All Server and Client Components: Installs the web server and client components.

AnyView Creator and Browser Client Components: Installs the client components for all of the
AnyView products.

AnyView — Web Server Components Only: Installs only the files used by the IS Web server

Custom: Allows you to select AnyView components for installation.

. If you choose Custom, the Select Components window appears. Select which components to
install:

AnyView Server System Files: Installs the web server files necessary to run AnyView,
including the web application files.

AnyView Browser Web Server: Installs the web pages for use with AnyView Browser.

MDAC: Installs the Microsoft Data Access Components 2.5 required on the web server.

. AnyView Documentation: Installs the AnyView installation, configuration, and user
documentation in the Microsoft Dynamics™ GP program directory.

AnyView Creator & Server Admin: Installs the AnyView Creator and AnyView Server
Administration modules for use with Microsoft Dynamics™ GP.

AnyView Browser Documentation: Installs the AnyView installation, configuration, and user
documentation in the AnyView Browser directory.

Click Next >.

If you elected to install AnyView Creator components during this installation, the MICROSOFT
DyNAMICS™ GP DIRECTORY screen will appear. Specify the folder where the Microsoft Dynamics™
GP application is installed. This folder is typically located on your local hard drive.

Important: The installation routine may default the installation to “C:\ Dynamics” or “C:\
eEnterprise”. If this is not the location where Microsoft Dynamics™ GP is
installed on your machine, you will need to specify the correct directory.

Verify that it is the correct directory, or use the BROWSE... button to select the location of the
desired version of Microsoft Dynamics™ GP.

Click Next >.

The installation routine will then begin to copy all files to the appropriate directories. The
InstallShield Wizard Completed window opens when installation is done.

If installing the AnyView — Server and Client Components, you will be asked to restart your system.
You are given the option to restart on your own or have InstallShield restart for you.

Click FINISH.
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2. Include the new code into Microsoft Dynamics™ GP.

If you are installing the AnyView Creator and Server Administrator, you will need to complete the
following steps.

Once the AnyView code files have been copied to your system, you then need to have Microsoft
Dynamics™ GP “include” the code.

To do so, start Microsoft Dynamics™ GP.

You will see a prompt asking you if you want to include the new AnyView Creator code, as shown in
the following illustration.

Dynamics

Mew code must bhe included inthe DY MNAMICS.SET dictionary,
Do yau wish ta include new code now?

. Click YEs.

A progress bar will display, while the “unchunking” process is executing:
This installation step accomplishes the following two tasks:

The DYNAMICS.SET file will be modified to include the information required to run AnyView.

. A dictionary named “AV2377.DIC” will be created in your Microsoft Dynamics™ GP folder.

3. Creation of Microsoft SQL Server Objects — Tables and Stored Procedures

When starting Microsoft Dynamics™ GP for the first time after installing AnyView, you must log into the
Application as the system administrator (sa or Dynsa or a user in the fixed sysadmin role ) in order to
complete the installation process.

When starting Microsoft Dynamics™ GP, you may be presented with the following prompt:

AnyView needs to be initialized by the system administrator or access has not been granted
to AnyView tables. Would you like to proceed with initialization now?

Select YES to create the required SQL tables and stored procedures.

This process does not destroy any data; it simply creates objects in SQL Server and grants access to all
users to these objects.

This process may take some time to complete and will report a completion status of successful or
unsuccessful. If you received an unsuccessful message, try the process again.
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Un-Installing AnyView Creator

If it becomes necessary to temporarily disable AnyView Creator on a Microsoft Dynamics™ GP
workstation, one can use the Microsoft Dynamics™ GP Tools->Customization->Customization Status
Window to Disable the Forms Printer product for one login Session.

In order to more permanently disable AnyView Creator on a Workstation, one must edit the Microsoft
Dynamics™ GP “Launch” file (typically named dynamics.set) to remove references to the AnyView
Creator Product (ID = 2377. Microsoft Dynamics™ GP provides a facility for editing the launch file from
the Tools->Setup->System->Edit Launch file menu. The Microsoft Dynamics™ GP Help Topic from this
window describes how to remove a product from the Launch File using a text editor, or the Uninstall
program applet can edit the .set file for you. (see below).

In order to Completely remove AnyView Creator and the Components that it installed, one should remove
the runtime components using Windows “Add —Remove Programs” Control Panel Applet, Then optionally
delete the AV2377.DIC AnyView Creator Dictionary, and optionally Drop the ASIAV* Tables and stored
procedures in the Microsoft Dynamics™ GP System and Company SQL Databases.

When using the Windows “Add —Remove Programs” Control Panel Applet, to remove AnyView Creator:
-You may wish to Answer YES to the prompt "Do you wish to remove AnyView from the
dynamics.set file.

Some Explanation:

In The Microsoft Dynamics™ GP environment, all enhancement products (like AnyView), register
themselves in a text file called Dynamics.set. - When uninstalling, they should be removed from the .SET
file - historically, this has been done manually, the un-installer provides the option to do it automatically or
you can elect to leave the .set file alone, but if you do, the AV2377.dic file will not be removed, since it
would cause fatal errors when starting Microsoft Dynamics™ GP until the .SET file was manually edited.

-Answer yes to the shared DLL question for
ASIWERDS.DLL,ASIWEDEFS.DLL,ASIEXPORT.DLL,ASIPROXY.DLL,ASIUTILITES.DLL,AV600
.cnk,asi_script.dll,asicrypt.dll

These DLL's can be used by other Accountable software programs, so they are marked as
"shared" which causes Installshield to ask the question.

-Click FINISH to the "Installation Complete" dialog - should say "uninstalled" — The uninstall may
cause a request for re-boot if dlls or other files were in use.

Svynchronizing AnyView Tables
After installing AnyView Browser, you will get a message that reads:

"The AnyView Utilities Process needs to run in order to use AnyView.
Do you want to run the process now?”

If you answer “Yes”, the synchronization process will run.

The synchronization is complete when all of the status boxes have been updated to Completed and the
Process button is enabled. You can then proceed to the registration process.
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Figure 1. AnyView Utilities Window.

The PrRocEss button on the AnyView Utilities window should be used to re-run the Synchronization,
whenever products/modules are added or removed from the Microsoft Dynamics™ GP Installation.

In cases where AnyView Browser is used to view data from multiple companies, The Synchronization
Process should be run once while logged in to each company, in order to update the company specific
User Defined Field Prompts that may vary by company.

The SYNCHRONIZE LOGINS button on this window is typically only used when upgrading from earlier builds
of AnyView Browser.

If you are upgrading a system using External Logins (Customers, Vendors, Salespeople) with AnyView
Browser, click the SYNCHRONIZE LOGINS button on the AnyView Utilities window. SYNCHRONIZE LOGINS
runs a ‘Check Links’ style verification on the records in the Internet Address table and the AnyView Login
tables. Any discrepancies found will be corrected and reported on the AnyView Login Errors Report when
the process finishes. An example of a discrepancy that would be corrected by the synchronize process is
orphaned records in the AnyView login tables. Should a record exist in the AnyView User Master table
that does not exist in the Internet Information table, this process would remove that record.
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Registering the Software

By registering your copy of AnyView, you will enable us to keep you informed of all enhancements,
improvements, and upgrades for the software. By communicating with you we can gather information
about additional Microsoft Dynamics™ GP enhancements that will work towards Enhancing The
Experience.

Software registration can also eliminate unauthorized use of software without imposing restrictive copy
protection.

Registration keys are provided by Accountable Software directly. For more information or to obtain your
registration keys, please call (484) 875-0600 or email mailto:ASlsales@accountable.com.

To register the AnyView Browser or AnyView Creator software:

1. Respond to the prompt.
2. Enter your Registration key.

3. Close the Registration window.

1. Respond to the prompt.
Start Microsoft Dynamics™ GP.

When starting Microsoft Dynamics™ GP, respond to the prompt that informs you that you are running
an unregistered version.

Click REGISTER.

The Accountable Software Registration window will display.

2. Enter your Registration keys.

Select the record for the AnyView Creator module by clicking in the Key 1 field.
. Enter the AnyView Creator key 1 exactly as you received it from us.
Tab to the Key 2 field and enter AnyView Creator Key 2 exactly as you received it from us.

If you are also registering AnyView Browser, repeat these steps entering the registration keys
you received for AnyView Browser.

Click REGISTER.
. Verify the User count and Expiration date.

If you mistyped the keys, you will receive a warning message. Try to enter
the keys again, and if you still receive a warning, contact Accountable
Software for assistance.
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3. Close the Registration window.

If the module(s) you are registering now appears with a checkbox in its Registered column, close the
Accountable Software Registration window.

You can reach the registration window any time by choosing Help > About Microsoft Business Solutions -
Microsoft Dynamics™ GP and then clicking Extras > AnyView from the toolbar.

Click the HELP button on the Accountable Software Registration window to send an email to Accountable
Software requesting assistance with registration.

AnyView Browser must be registered separately from
AnyView Creator using separate registration keys.

Technical Support

Accountable Software Customer Support is available Monday through Friday from 9:00 am to 5:00 pm
Eastern time. Support is charged on a per-incident basis.

Customer Support can be reached in the following ways:

610.983.3100 option: 1

TechSupport@accountable.com

http://www.accountable.com

When you call, fax, or email Accountable Software for support, please include the following information:

Your company name and phone number.
Your name.

. The name of the product you are working with and the version you are running (from the
registration window).

A brief description of the problem.

In addition, have this manual available when you are connected with Customer Support—you
may be directed to various pages in the manual as you receive assistance.

Please also be aware that all technical support issues are chargeable unless the issue you are
calling about is a result of a defect in an Accountable Software product or accompanying
documentation. Customers without pre-paid support incidents, will be required to provide
credit card information prior to opening an incident, but will not be charged if the call is
nonbillable. For the latest Accountable Software Support Policies, see the “Support” section of
the Accountable Software Web site. www.accountable.com
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About AnyView Creator

AnyView Creator is a wizard style interface that allows you to create views in SmartList based on any
table in your system including third party tables and tables external to Microsoft Dynamics™ GP (such as
Siebel or other external products). You can define links to other tables, choose which columns are
available to be searched on, and which columns are in the default view. You can also change the column
display types, formats and names.

AnvView Creator Window Navigation

The following items are added to your Microsoft Dynamics™ GP menus during AnyView Initialization:
Several of these menu items apply to AnyView Browser only.

@ Microsoft Business Solutions-Great Plains

File Edit Yiew BEEES Transactions Inquiry Reports  Cards  Extras  Windows Help Debug

sa | Fabrikam, ]  2efup LT [E, ‘{} lffi E}, L;?- ""_':'_Lr.

p— Lilities LY = 4 Reconcile
A al Routines »  Company | Remove Rates
Shorteuts (8 Customize * Financial k Ackivity Detail
Inkegrate k Sales L4 Process Server
add [Elf wigw ~ Macro * Purchasing * Business Alerts
" o Inventary Ay Creator \Wizard
il User Prefere Resource Descriptions ¥ Pavral , &Y GoTo Setup
(] Sharteuts AY Drill &rounds
Startup AY DSM Setup
] User Classes &Y External Tables

AV Login Alias Setup
&M Web Page Setup
AY Login Page Creator
a4 Ukilities

a4 w'eb Obiject Setup
A4 w'eb Goko Setup
&4 Object Audikar

The following Menu Items are used for the AnyView Browser Report Publishing Feature.

Inquiry Reports Cards Extras Windows Help Debug

Setup '/ T Bk || [ T W
LIkilities » Syskem »
F Routines L4 Compary  F Remove Tax History
Customize » Financial » Enable Euro
I Integrate L4 Sales L4 Arrytiew Ay Repaorts
| Macro L4 Purchasing * Ay Report Groups
Resource Descriptions » Inventary  k A% Report Access
= Payrall » A Report User Access
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AnvyView Creator Windows

Menu ltem

Window

AV Creator Wizard

AV GoTo Setup

AV Drill Arounds

AV DSN Setup

AV External Tables

AV Login Alias Setup
AV Web Page Setup
AV Login Page Creator
AV Utilities

ASI_AnyView_Creator_Wizard
ASI_AnyView Goto Maintenance
Drill_Around_Wizard

Applies to Browser Only
AnyView External Tables Setup
Applies to Browser Only

Applies to Browser Only

Applies to Browser Only
ASI_AnyView_Ultilities

AV Web Object Setup

Applies to Browser Only

AV Web Goto Setup

Applies to Browser Only

AV Object Auditor

ASI_AnyView_Object Auditor

ANYVIEW
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AnyView Creator Security Roles and Tasks

With the new Security model implemented beginning with Microsoft Dynamics™ GP 10, it becomes
necessary to enable Users to Use or Administrate AnyView Creator by Placing the Users in GP Roles
that are made of GP Tasks that allow access to various program and code resources.

When AnyView Creator Is initialized and logged into the first time, by ‘sa’ or ‘DYNSA’, The Following
Tasks and Roles are created:

Roles: (ANYVIEW_OBJECT VIEWER)

M Security Role Setup -0l x|
File Edit Tools Help Debug sa Fabrikam, Inc. 4/12{2017
[ Save | A Clear | » Delete | Copy | 5
Rale ID: ANYVIEW_OBJECT_VIEWER
Rale Marne: Aruhfign object viewer
Rale Description: Apyfiew object viewer
Display. Al - Makal | Unmarkan |
Security Task ID = | [Mame | ﬂ
[ ] aDMIM_SyYSTEM_013* System tables
|:| ADMIM_SYSTEM_SLO1* Set up Advanced Lookups
[ ] ADMIN_SYSTEM_SLOS* SmartList Tables iy
AMYVIEW _CREATOR_OBJIECTS View AnyView Creator built Smartlist objects
|:| CARD _Qo01= Maintain currency exchange rates
|:| CARD_Dooz= Maintain organizational tree
|:| CARD_0Q003* Maintain Business Alerts
|:| CARD_D101% Maintain accounts
|:| CARD_D102% Maintain account analysis
|:| CARD_0103% Maintain budgets ;I
[4 4 + K L_JI' (7]

All Dynamics GP users who need to View ALL AnyView Creator Objects should have the
ANYVIEW_OBJECT_VIEWER Role added to their user security role list. Typically one would create
other ANYVIEW_OBJECT?* roles with Specific AnyView Object Smartlist Tasks for higher Granularity of
Object Security.

The Task ID above, can be duplicated, and then modified, if you need to apply finer grained control to
users with regards to which AnyView Creator Smartlists they can view.

If all users need access to ALL AnyView Objects, one can add the ANYVIEW_CREATOR_OBJECTS

Task or other Specific Task IDs that include Smartlist objects Created with AnyView Creator, directly to a
broadly applicable role which many users already have been placed in, such as “ORDER PROCESSOR”
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Additional Role Created upon Initialization:
Role: (ANYVIEW_ADMIN)

i %)

File Edit Tools Help Debug sa Fabrikam, Inc. 4/12/2017
[ S5ave |<ﬂ Clear |X Delete | Copy | 5

Rale ID: = ANTVIEW ADMIN

Rale Mame: Aruhfiey Creator/Browser Adminiztration

Fole Description: Run Creator wWizard, External T able wizard, and &% Utilities, and "Web

Display: |4 - Mark Al | Unmark Al

Security Task D~ | rame | =

ADMIM_AMYVIEW 01 = Set up AnyView Creator Browser Objects - Create Mod b
|:| ADMIM_COMPAMNY _001* Set up company

(] ADMIN_COMPANY_002* Set up taxes

|:| ADMIN_COMPANY _003% Set up payment terms and shipping methods

|:| ADMIM_COMPANY 004 Set up bank accounts

|:| ADMIM_COMPAMY_005% Set up credit cards

|:| ADMIM_COMPAMY_00&8% Set up customer fvendor consolidation

[] ADMIN_COMPANY _007= Set up posting

|:| ADMIM_COMPAMY_008% General company administration

|:| ADMIN_COMPANY _009™ Modify period-end routines ;I
44 b b Ir @
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Tasks:
The Default Security Task ID’s for AnyView Creator are defined as shown below:

Note the ANYVIEW_CREATOR_OBJECTS task, manages Smartlist Objects from the Product Smartlist,
(even though the objects are created by the product AnyView Creator.)

_ioi

File Edit Tools Additonal Help Debug sa Fabrikam, Inc. 4/12/2017
[ S5ave | A Clear | » Delete | Copy | 5
Task D = ANYVIEW_CREATOR_OBJECTS Category = |System -

T ask Mame Wigw e Creator built Smartlist objects

Task Dezcription Baze Tazk for allowing roles to Wiew all Ariew Creator Created Objects that were placed in this Tz
Froduct: =  SrartList -

Type: = SrnartList Object -

Ceres: = | SmartList Objects -

Makal | Upmakal |

Access List:

Operations = I:I
|:| test

|:| Vendor Addresses
|:| Vendor Items

|:| Vendors
|:| Work Crders
I_Aviestl =
|:| hotask

|:| FTestadd j

Print Operation Access

RN O w
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Eile Edit Tools Additional Help Debug sa Fabrikam, Inc. 4/12/2017
[ Save | A Clear | > Delete | Copy |
Task ID ADMIN_AMYWIE W _01 Cateqory System -
T azk Mame Set up Arptiew Creator/Browser Objects - Creates/Mod
T azk Dezcrption Fun Creator Wizard, External T able Wizard, and &Y Utilities, and "Web Object Settings
Product, o |Zunytfiew =
Type: = Windows =
Serez: = | Company -
Mark &1 Unmark &1l |
Access Lisk

Operations = |
AnyView Browser Gotos

AnyWiew Creator Wizard Control
AnyView Detail Page Wizard Control
Anyview Drill Around Wizard
AnyView DSN Setup

Anyview External Tables Setup
AnyWiew File Extension Maintenance
AnyView Goto Maintenance
Anyview Gotos

Anyview Login Alias Setup

AnyView Login Page Generator
AnyWiew Cbject Auditor

AnyView Report Group Maintenance
Anyview Report Publishing Maintenance
Anyview Report Security By Report
AnyView Report Security By User
AnyWiew Utilities

AryWiew Web Page Setup

[ ] asI sgL Utilities

AST User Activity

Control

Control

Drop Down List Maintenance

Edit Field Datatyps

Enter Favorite Parameters

Field Format Maintenance

Join Window

Login Alias Maintenance

Select Column

|:| Test Restriction

User Defined Field Maintenance

[] B script Test

Frint Operation Access

4 4 ¢ # 9@

The ADMIN_ANYVIEW_01 Task contains access to all of the Windows needed to set up and administer
AnyView Creator.
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AnyView Creator Wizard

Welcome

To open the AnyView Creator Wizard, go to Utilities > System > AV Creator Wizard.

The AnyView Creator Welcome window begins the wizard with a dropdown list of the actions you can

perform with the Creator wizard.

i@ Anyview Creator .F; ;IQIEI

Welcome to the AnyView Creator

AnyWiew Creator can be used to create new objects
within Great Plains Explorer. Once the ohject is created,
all warkstations with AryWiew Creator loaded will be
capable of taking advantage of all of Explorer's benefits
weith thiz newy abject .

Anyview Creator can create Explorer objects far every
table within the eEnterprize environment, including tables
provided by integrating products.

Chooze the AnyWiew Creator Action and select Mext to
continue.

Action: Define a new object -

Mext 33> I Cancel

Figure 2. The AnyView Creator Welcome screen.

Actions on this screen include:

. Define a new object

. Import a new object

. Modify an existing object
. Export an existing object
. Delete an existing object
. Import Gotos

. Export Gotos

These actions are detailed in the following pages.
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Define a New Object

Select Main Table
The SELECT MAIN TABLE window allows you to search tables by Product or Series. The table you choose
on this window will be the main table for your object.

& Select Main Table o o] o4 |

Select Main Table
Select the main table for the object and zelect Next.

Fird
Riestrict Mare - eEnterprize -
tain Table Cuztomer b aster Address File

Display Mame | Group Name | Series | Te::l
Campany Master Syskem POI
Company Master - HR. Alias Campany Master Syskem HR.
Company Report Opkions Company Report Opkions Cornpany S
Configuration Master Service Project S
Contrack Liability Wiew Project AS
Credit Card Master Credit Card Master Campary SY.
Currency Setup Mulkicurrency Syskem Setup Syskem MC

Cuskomer Master Address File RM Customer MSTR. Logical File

Cuskomer Master Address File Archive Sales RM
Cuskomer Masker Summary RIM_iCustomer _MSTR_Logical_File Sales R
Customer Period Summary RIM_iCustomer _MSTR_Logical_File Sales R
Customer Site Extensions Service Project S
Customer Site Schedule Service Project i
Data Collection Line Ikems HR,_ther JrdParty  Dal
Mak= Callarbinn Teanezekion | an HO  ither Qe Dzwkus [nE
4] | 3

Tablelnfnl << Back I Mext »> I Cahicel |

Figure 3. The Select Main Table screen.

Select the main table (or SQL Server view) and click NEXT >>.

NOTE: AnyView performs the Join from the main table to the secondary tables as a “left outer
join”. Therefore, if you are creating an object that contains a one-to-many relationship between
two tables, you should select the “Many” table, which defines the records that you want returned,
as the Main Table. For Example: in a Join between SOP Documents and Customers, You would
want SOP Documents to be the main table if you wanted to list all SOP Documents and the
additional Customer data associated with each.

NOTE: As of AnyView Build 86, the Tables visible in this window and the Additional Tables
window may be restricted for a given user by using the Microsoft Dynamics™ GP Setup->System-
>Security window to restrict access to type: 'Files'.

The "Files" that are secured in this manner are actually Microsoft Dynamics™ GP "Table Groups".
For example, the Microsoft Dynamics™ GP Product 'File' shown as ‘Inventory Control' under the
inventory series on the Microsoft Dynamics™ GP Security Setup Window is made up of 3 physical
tables (IV40100,IV40800,IV40900) as shown by Microsoft Dynamics™ GP Tools->Resource
Descriptions->Tables->Table lookup.
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Select Additional Tables
From this window you can choose the other tables to use in the view. Highlight the table and click Abbp to

add it.

= Select Additional Tables —10] =l

Select Additional Tables
Add additional tables by selecting then in the list and zelect MNext.

Find
Festrict MNone - eEnterprise -
Main Table Cusztorner b aster Address File
Display Name | Group Mame | Series | Tec;l
RM Apply Reprint Journal File RM_BEatch_History _Logical_File Sales RM
RM Eatch Histary RM_BEatch_History _Logical_File Sales RM
RM Cash Receipts Wark File RM_Open_Transaction_Logical_File Sales RM
RM Class Intrastak MSTR Sales R
RM Commission Wark File RM_Open_Transaction_Logical_File Sales RM—
RM Customer Inkrastat MSTR. Sales R
RM Customer MSTR, RM_Cuskomer _MSTR_Logical_File Sales RM
Rl‘i1 Customer MSTR. | Sales RMT
4 »

Fitd Customer M5TR

Bemove |

Tablelnfol << Back | Mext 33 | Cancel |

Figure 4. The Select Additional Tables window.

Select additional tables by highlighting them and clicking the Abb button.

Once you have selected all tables for this object, click NEXT >>.
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Define Table Joins

The tables added to the view must be joined together by a field or fields from each table. The DEFINE
TABLE JOINS window automatically joins fields based on the selected key of the Table to join to, if fields of
the same name and datatype are found in the table to join from. If this is not the field you want to link
with, you can change the linking field by either changing the table key or choosing another field from the
FIELD TO JoIN TO lookup. To create a proper join, you must be able to link all fields in the Secondary table
key with a field from the Main table!. For SQL Server databases you may wish to select ‘Other’ as the
table key ,in order to allow you to use any columns desired to create the SQL join.

All tables in the Object must be properly joined to save this screen. The Creator wizard populates as
much of the join information as possible in attempting to ensure that you complete the join information

properly.

i@ Define Table Joins _ ol x|

Define Table Joins
Create a definition of the join between the tables.

T able ta jait from

Cuztomer b aster Address File

Select table key Fib_Customer_MSTHR_ken -
Cuztarner Master Address File |Q| Rk Custarner MSTR |_|
Customer Humber Custorner Number -
-
<< Back Mext 33> Cancel

Figure 5. The Define Table Joins window.

Click NExT >>to complete the Joins window.

Technical note: The join created by AnyView Creator is always a left outer join. For Pervasive and C-
tree databases, The AnyView Creator wizard will only display columns in the joining table that are part of
a key.

I As an aid to finding the tables and joins needed for creating an object, you can use several sources and
methods. One method is to find a report in Great Plains that is similar to the object you are creating. By
examining the report in Report Writer, you can find the tables and relationships used to create the report.
These relationships can help define the necessary joins for your object. Other sources of table and join
information are the Great Plains SDK (Software Developers Kit) found on CD2, and the Table
Descriptions window in Great Plains (this window can be found under Tools >> Resource Descriptions >>
Tables).
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Object Restrictions
Object restrictions can be used to narrow the list of records that are returned to the AnyView Browser.

To create a restriction:

Select the desired TABLE from the drop down list of tables

Specify a FIELD by typing its name or selecting from the lookup

Specify a SEARCH TYPE

Select a restriction TypPE from the drop down list. Possible values include: contains, is equal to,
begins with, is between, is not equal to, is greater than, and is less than.

Specify the FRom value for the restriction

Specify the To value for the restriction when using the BETWEEN restriction type.

Click the ADD RESTRICTION button to add the restriction to this object.

When you are done creating restrictions, click the NEXT >> button to proceed.

i@ Object Restriction -] x]
Select Object Aestriction
Select Object Restrictions and select Mest.
) Restrict By
Table Field Search Type
@ Login i
Customer M azter Address File w | Salezperson 1D v Match &l v a
- I- -
-
iz equal ko Y
Type is equal to -
Fram |
To
[~ Match Case
Remowe Restriction | Add Restriction |
b
<< Back I Mext »» I Cancel |

Figure 6. The Object Restriction window.

Note: This window is also used to implement Role Based Login Security. For a discussion of this
capability, see the Role Based Login Security section of the AnyView Browser documentation.

Note: If you are creating a restriction for a Drop Down List data type, you must use the literal description
of the value, not the numeric value (i.e., if restricting SOPHeader.Type, use “Order” instead of “0”).

Click NEXT >> to complete the Object Restriction window.
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Select Columns to Include

From this window, you can define which columns will be available in the view. Select any columns that
you may want to display in the SmartList or AnyView display or search on from the SmartList or AnyView

search window.

By omitting columns from the object, you can implement column level security on your object. Any
omitted field cannot be used in the display, restriction or search of an object.

@ select Columns to Include

Select Columns to Include

Select the columng to be included in thiz object and select Next.

Cuztomer b aster Address File

Address Code Cuztomer Mumber -
UPS Zone Salesperson D
Shipping Method Address 1 b
Tax Scheduls |D | Contact Perzon
Address 2 al>> )
Address 3 City
County State
‘Phone 2 Remove | Zip
Phone 3 Phare 1
Fax
Modfied Date R B L)
Created D ate
-
<¢ Back Mewut »» Cahicel

Figure 7. The Included Columns window.

Click NEXT >> to complete the Included Columns window.
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Select Default Columns

This window allows you to define which of the selected columns for the view are displayed in the default
view of this object. You can also add formatting to the fields in your view while creating the object. By
clicking on the column name, you edit the name to appear as you would like it displayed in SmartList and

AnyView.

& Select Default Columns

=101

Select Default Columns
Select the columns to display in the default favarite and select Mext.

W i Customer Name
W & Salesperson D

WV 5 Addess

¥ & Conkact Person
IV O Ciy

WV & State

¥ Jf] Zip

V & Phonel

L

Markal | H unmakan | «Back [ Newss |

Cancel |

Figure 8. The Default Columns window.

By clicking on the column expansion button, you will open the format column window. Here you can enter
data type, format, dropdown list and user defined values while creating your object. This can also be
done using the AnyView Utilities window. For detail on each of these formatting options see the section

titted ‘Modifying AnyView Creator Views'.

& Format Column ]

Datatype -
Farmat String
MHegative Values

™ Use user defined label

Dirop Diowen List [tems ™ Zemo Baszed Drop Down List

Mumeric Yalue | String Yalue [rata Yalue

|

-

‘/ Ok I ° Eancell

Figure 8a. The Format Column window.

Click NEXT >>to complete the Default Columns window.
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Column Summary Options
The CoLuMN SUMMARY OPTIONS window allows you to add simple totaling functions to your object. Each
column with a data type of Currency, Integer, or Long, will be displayed when the window opens.

& Column Summary Options o ] B4 |

Select Column Summary Options
Define the column summarny options for this object, and select Mewt,

Colurin |Average |Adiustments
Document Smaournt r |
Line Item Sequence r - -
Times Fepeated r r

<< Back I Mewt »> Cancel

Figure 9. Column Summary Options window.

The available summary operations are:
e Sum — Creates a grand total for the value in the selected column.
e Average — Displays the average for the data in the selected column.

To alter the results of the Sum or Average calculated, click the Adjustments button.

Note: Summary Options are implemented in AnyView Browser only. For information
regarding totals in the Microsoft Dynamics™ GP SmartList, see the SmartList
Totals section of this document.
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Column Summary Adjustments
The CoLUMN SUMMARY ADJUSTMENTS window allows you to build logic into the summary operation by
selecting a conditional column on which to transform the data.

=10l x|

Column Ta Summarize Dacument Amaunt

Add adjustment criteria in arder to modify the data in the column az it iz summarized. [f
a data row does not match any adjustment criteria it will il be included in the
SUMIMArY.

Colurnn that determines if Document Amount zhould be adjusted:

SOP Type

[f SOF Tupe
|z Equal To | Retun
Then Force Data Megative = Add Adjustrment |
Dacument Amaunt Adjustments
Remaove =
Remove Al -

V/ ] a Cancel |

Figure 9a. Column Summary Adjustments window.

To Create a Summary Adjustment:

1.

4,

5.

Using the Column Lookup button, select the column that contains the value on which to base your
adjustment.

Enter the column value that creates the desired condition.

Choose the operation from the “Then” dropdown list. Choices for the operation are:
e Force Data Positive
e Force Data Negative
e Multiply by -1

Click the Add Adjustment button to insert the condition into the list.

Click OK when finished entering adjustment conditions.

Multiple conditions can be added to the Adjustments list, however all conditions must be based on a
single column. If a value is found in the selected column that has not been added as a conditional value,
that record’s column will be added to the total with no adjustment applied.
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Select Gotos
Object Gotos are actions that can be taken based on the selected record or the entire result set in your
view. These Gotos are divided into two categories. Code Gotos and Drill Arounds.

Code Gotos

Through VBScript or Dexterity code, Solution Developers can create custom Gotos on objects created
using AnyView Creator. These Gotos can then be launched using Microsoft Dynamics™ GP SmartList
so users can drill into maintenance and inquiry windows from custom SmartList objects results.

Gotos can be exported from and imported into AnyView, so end user organizations that lack Dexterity
and VBScript expertise can obtain Goto code for their critical SmartList objects?. Pre-built, importable are
installed in the ‘AnyView (8.00)\Example Goto Actions' folder within your Microsoft Dynamics™ GP client
install folder. There is a file for each Goto, and a combined file, containing all of the Gotos.

Drill Arounds

A drill around is a means to navigate from one object to another, using the selected record in the source
view as a restriction for the second view. Drill arounds must be defined using the Drill Around wizard
before they can be attached to an object in Creator.

To create a Goto:
Use the Goto lookup window to select GOTO ITEM.
Specify the MENU PROMPT that will appear on the SmartList Goto menu.

When you select the Goto Item, the lower grid will fill with required Goto parameters. For each,
specify the ASSIGNED FIELD in this object that will serve as the parameter value.

@ Select Gotos s

Select Object Goto
Select tems that will appear on the Goto menu within Explorer and select Next.

Order Goto ltem |Q|Eiot0 Menu Prompt
1 Open Salesperzon Maintenance Open Salesperzon Maintenance -
a
-
Goto Yariable Azzigned Field |Q|
Salesperson (D] Salesperzon 1D -
w

<4 Back I Mext > I Cancel

Figure 10. The Select Gotos window.

Click NExT >>to complete the Gotos window.

2 Goto and Drill Around Maintenance is detailed in a later section of this document.
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Object Security

The OBJECT SECURITY window allows you to assign access to the object being created while in the
Creator wizard. The only option is to have the wizard Assign the current Smartlist object to the fixed
Security Task ID = ANYVIEW_CREATOR_OBJECTS. This task would normally be granted to a
Dynamics GP Role that any AnyView Object Testers or Designers would have assigned. The Object
would normally be assigned to other GP Tasks using the Dynamics GP Security Windows (see : AnyView
Creator Security Roles and Tasks)

File Edit Tools Help Deb

Fabrikam, Inc. 4/12/2017

=]

Object Security
Arnyiew Creatar Object Security iz now maintained with Dynamics GP Smartlizt
Security Tazks.

W &dd This Smartlist Object ta the ANTYIEW _CREATOR_OBJECTS Securty Task

<< Back I Mext > Cancel

Figure 11. The Create AnyView Object window.

Click NEXT >>to complete the Security window.

Create Object
The CREATE OBJECT window allows you to hame the object as you would like it displayed in SmartList.

Enter the name for the view in the space provided.
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& Create Object

Create Any¥iew Object

Review and save your selections.

Object Mame
by Cugtomers

eEnterprise Explorer must be clozed and reopened on all workstations after selecting Finish for
these changes to take effect. Failure to do g0 may cauze unexpected results.

<¢Back |I Finish

Cancel

Figure 12. The Create AnyView Object window.

*** After clicking FINISH, the new object will appear in SmartList and AnyView the next
time they are opened. To modify access to this Object, use the modify object option of
the AnyView Creator wizard or the SmartList Security window (from Utilities > System >

SmartList Security).

Note: It is recommended before creating a new view, that you close SmartList on all workstations, as this
process modifies the table data and can cause unexpected results.
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Modify an Existing Object

AnyView Creator allows you to modify objects that have been created with AnyView Creator. Once the
object is created, you can add tables, and columns to the object, change both the included and the
default column list and change summary information. Note: You cannot remove Tables once an object is
created.

Warning: If existing Columns of an object are removed or re-ordered, all Saved
Favorites and all Column Formatting for the object will be Deleted for all users. If
an object already has many favorites created, you may wish to create a new
object instead of modifying an existing one.

Delete an Existing Object

Objects created with AnyView Creator can be deleted from SmartList through the AnyView Creator
wizard by selecting the DELETE EXISTING OBJECT action from the Welcome window and following the
wizard instructions.

Export an Existing Object

Existing objects created by AnyView Creator can be exported to a file, and then imported on another
system, provided the other system also has AnyView Creator. Exporting an object does not affect the
original object; it will remain in your system. To export an object, choose the EXPORT AN EXISTING OBJECT
action and click NExT >>. Choose the object to be exported then click NExT >>. Enter or browse to the
path for storing the exported file, then click NExT >>. Click FINISH to complete the export.

Import a New Object

New objects can be imported from files created by another system by choosing the IMPORT A NEW OBJECT
option. Click NExT >> then select the file to be imported. From the create object window, you can change
the name of the object being imported from its original name. Choose FINISH to complete the import.

An imported Object will initially be visible to only the user who imported it. To grant access for this
Object to other users, use the AnyView Creator Wizard or the SmartList Security window (from Ultilities >
System > SmartList Security).

Note: Objects containing External tables or SQL Views can now be imported and
exported. For detailed information on this process, see the Exporting and
Importing External Table Objects section of the AnyView Browser
documentation.

Export Gotos

Existing Goto code can be exported into a text file for shipping to another location. To export Gotos,
select the EXPORT GOTOS option on the main Creator window. Click NEXT >>. Select the Gotos you wish
to export from the list provided. Click NEXT >>. Supply a name for the export file. Click NEXT >> to
proceed. Click FINISH to create the file.

When exporting Gotos, Creator creates a file of all the selected gotos. From the Export Gotos window,
you can create a single export that contains multiple gotos.
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Import Gotos

Files of Gotos can be imported into by AnyView Creator. To import Gotos, select Import Gotos from the
main Creator window. Click NExT >>. Creator will ask you for a file name. Supply one, or browse to one,
then click NExT >>. Click FINISH to import the file.

Pre-built, importable Gotos for many Microsoft Dynamics™ GP windows are included with the

AnyView product.
These files are installed in the ‘AnyView (8.00)\Example Goto Actions' folder within your Microsoft
Dynamics™ GP client install folder. There is a file for each Goto, and also a combined file, containing all

of the Gotos.
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Modifying AnyView Creator Views
To open the AnyView Creator Utilities window, go to Utilities > System > AV Utilities.

After creating a new view with AnyView Creator, you may want to edit the way certain fields display in
SmartList and AnyView. For example, you can change the format of phone numbers and show the Sales
Order Processing Document Type as the text “Order” instead of the number 2. AnyView Creator allows
you to define formatting, datatypes, user defined prompts, and dropdown lists.

From the AnyView Utilities screen you can open the maintenance windows where you can perform each

of these actions. You can also use the Creator Wizard Format Columns window to perform the same
modifications.

AnyView Utilities

i AnyView Litilities i =11 x
4§  Proces: Synchionize Logine

Update Shabus Fiogiess

F |l:l:l[|lu|ah..pcs__ Dirop Diowin Lists Field Fomatz Uzes Diefined Promptz 5N Sehp

Figure 13. The AnyView Utilities screen.

The processes and screens for each of the buttons on this screen are detailed in subsequent sections of
this document.

Process

The PROCESS button is used to rebuild AnyView’s list of tables for each product in your system. This
process should be run whenever a product which is part of your Microsoft Dynamics™ GP installation is
upgraded or a new third party product is loaded. This allows AnyView to create and display objects based
on that product’s tables.

Synchronize Logins

The SYNCHRONIZE LOGINS button is used only if you have AnyView Browser installed, and you are utilizing
the External Logins Functionality of AnyView Browser. The purpose of the Synchronize Logins button is
to run a ‘Check Links’ style verification on the records in the Internet Address table and the AnyView
Login tables. Any discrepancies found will be corrected and reported on the AnyView Login Errors Report
when the process finishes. An example of a discrepancy that would be corrected by the synchronize
process is orphaned records in the AnyView login tables. Should a record exist in the AnyView User
Master table that does not exist in the Internet Information table, this process would remove that record.
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Field Datatypes
This screen allows you to change Datatypes for selected columns in your Objects.

i& Edit Field Datatype - |of x|
Wigw tp Orders -
Colurnns

Custorner M ame

Custorner Number
Custorner PO Number
Diocument Armount

Document Date
Order Date
SOF Mumber
SOP Tepe

™ User Defined Field
Current datatype Currency

Change datatype to

& sSave |

Figure 14. Field Data Types.

To use this screen:

Select a view (Object).
Select a column in that Object.

. Select a datatype from the drop down list box.

Click SAVE.

For example, a Salesperson view created using the ASI Commission Work table Commission Plan
contains a currency field ASI_Salesperson_Net_ Comm_Amt. This column is a stored as a float field in
the table, but can be displayed as a currency in SmartList by changing the datatype to currency.
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Dropdown Lists
This screen allows you to create meaningful lists of information that correspond to more cryptic code
values inside the database.

Below is an example of a drop down list that will translate Order Type codes into meaningful labels.

i@ Drop Down List Maintenance - |EI |£|

Wi by Orders -

Drop Down List Columns

Walues are for # 2l Companies £ This Company |

[~ Zemo Based

Mumeric Walue String Walue Data Yalue |
1| Guote 0 a
2[0rder 0|
3| Invoice 0
4| Fetum a
B|Back Order 1}
0 0 -

n Save |° LCancel |

Figure 15. Drop Down List Maintenance.

To set up a drop down list for a column:

From the View dropdown list select the view containing the fields you wish to edit.
. Displayed in the columns list are all of the dropdown list columns in the selected view.
Click the desired column in the column list.
Add the string values you wish to use in SmartList.
For each string value added, you must enter a numeric value in sequential order.

. If the column is a Microsoft Dynamics™ GP field, the Numeric Value and String Value will fill in
automatically.

When editing dropdown lists, you can choose whether this dropdown list change applies only to
the current company or all companies by toggling the radio buttons for VALUES ARE FOR....
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Field Formats
This screen allows you to specify formats for columns in your objects. For instance, you may want to set
formatting for Social Security numbers, phone numbers, et cetera.

i@ Field Format Maintenarnce k - ol x|
e Sales Summary -

Columns

Format Applies To # 2l Companies
¢ Thiz Company
Format String
Postive Valuss Ll
Megative Values ot e

EH Savwe |

Figure 16. Field Format Maintenance.

To use this screen:

From the ViEw dropdown list select the object containing the fields you wish to edit.
. Displayed in the columns list are columns in the selected view.

To change the format, click on the column in the column list, then enter a value in the PosITIVE
VALUES field and it the NEGATIVE VALUES field if it applies to the particular field you are editing.

This format can be applied to either the current company or all companies by toggling the
FORMAT APPLIES TO... radio buttons.

An upper case “X” is the placeholder.

The format for a Social Security number is XXX-XX-XXXX.

Other common formats include: (one must always include at least 4 ‘X’ characters for numeric formats,
for correct operation, this also allows the thousand separator, if present, to be correctly detected.)

SX XXX XX Formats currency fields with a dollar sign, a thousands separator, and 2 decimal places.
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X, XXX Formats fields such as Quantity fields with a thousands separator and no decimal places.
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User Defined Prompts

Because user defined fields will be displayed in your view as “User Defined ...” and not the value you
have entered as the prompt, you can use the User Defined Maintenance window to edit the prompt
displayed by SmartList or AnyView.

Ld User Defined F - o] x|

Wigw Purchase Orders By Wendor -

Uzer Defined Columng

Frompt Appliez To ® Al Companies
€ This Compary

Frompt

Figure 17. User Defined Field Maintenance.

To use this screen:

From the View dropdown list select the object containing the user defined field you wish to edit,
then click on that column in the column list.

Determine whether this prompt applies to only the current company or all companies by
toggling the PROMPT APPLIES TO... radio buttons.

Enter the prompt you want SmartList to display in the PROMPT field.

ANYVIEW 37 Accountable Software



AnyView Goto Maintenance

Accessed from the Utilities > System menu, AnyView Goto Maintenance allows administrators and
implementers to create custom SmartList functionality for newly created objects.

One of the key benefits of SmartList is that it provides “drill around” or “goto” functionality that allows
users to open Microsoft Dynamics™ GP maintenance or inquiry screens pertinent to the database entries
being viewed. For instance, when viewing a customer list, the user can drill into Customer Maintenance,
Address Maintenance, Customer Transaction inquiry, et cetera.

AnyView Creator provides this functionality by allowing implementers to author Dexterity or VB Script
code and position that code to provide Goto functionality for Creator objects.

@ Anyview Goto Maintenance . - o] x|
B Save | Test | & Clear | % Delete |
Gato Mame Open S alegperson Maintenance
Product eE nterprize -
Script Scope | Once for Selected Row -
Seript Type Sanscript -
Script 4 in string  [N_Salesperson; -
open form AM_Salespersan;
L) Temp Control Mumber' of window Bk_S alesperzon of form BM_S alesperson = IN_S alespers
run script '[L] Temp Contral Humber' of window Rk_S alespersan of form RM_S alesperzan; —
4 | | 4
Farameter D atatype Wariable Mame Prompt |
1| Shing * | IN_Salezperzon Salezperzon (D -
0 -

Figure 18. The AnyView Goto Maintenance screen.

To use this screen:

. Specify a GOTO NAME or select one from the lookup window.
. Select a PRODUCT for use with this Goto.
. Specify the Goto SCRIPT SCOPE:

. Once for Selected Row — executes the Goto for the row selected in SmartList
. Once for Every Row — executes the Goto for each record in the SmartList result set

. Select a ScrIPT TYPE of either Sanscript or VBScript.
. Type in the SCRIPT text.
. Specify the parameters for the script®.

You can test the script by clicking the Test button at the header of the screen.

3 The Variable Name field must be named for passing parameters to VB Script.
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AnyView Drill Around Wizard

Welcome
To open the AnyView Drill Around Wizard, go to Utilities > System > AV Drill Arounds.

The AnyView Drill Around Welcome window begins the wizard with a dropdown list of the actions you can
perform with the Drill Around wizard.

iE Drill Around Wizard

=101 x|

Welcome the the AmAfiew Drill Around Wizard

The AnyWiew Drill Around Wizard can be used to creste
shecialized gotos within Any™ies wwhich will allow you to
link one object to another ..

Drill Arounds are available for use wwithin 2ny™iesn
Creator and Anyiewy Browser,

Chooze and Action and zelect Mext to continue.

Action: i a Drill Around -

Mest »» Cancel

Figure 19. The Drill Around Welcome Window.

Actions on this screen include:
Create a Drill Around
Modify a Drill Around
Delete a Drill Around

These actions are detailed in the following pages.
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Create a Drill Around

Select Object
The select object window displays a list of all of the default SmartList objects, and any objects you have
created with AnyView Creator. Select the object which you would like to be able to drill to.

& Select Dbject

Select Object

=10 =]

Select the object this Drill Arounds navigates to and select Mest,

Obiject Mame

| CObject Dictionary:

Account Summmary
Account Transackions
Accounts

Applicant

Applicant Education

AM Account Summary (Current) Sample A
A4 Account Summary (Currenk) Sample Arveigm
&Y Sales Line Tkems (Open) Sample Arryigm
&Y Sales Transactions (Hisk) Sample By
AV Sales Transactions (Open) 2 A
&Y Sales Transactions (Open) Again Arveigm
&Y Sales Transactions (Open) Sample Arryigm
&Y Sales Transchions (Open) W2 By -
[u1 LT i Comle H

eEnterprise
eEnterprise
eEnterprise
Huran Resources
Hurman Resources

Cancel

Figure 20. The Select Object Window.

Once you have selected object for this Drill Around, click NEXT >>.
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Select Criteria
The Select Criteria window allows you to enter restrictions for your drill around. These restrictions are
defined by two different types. Drill around restrictions, and drill around.

Drill Around Restrictions

A restriction for a drill around is a column or columns that filter the records by a predefined value when
the drill around is used. For example, If you wanted to create a drill around that listed only orders using
the Sales Transaction object, you would choose the SOP Type column, and enter a drill around restriction
of ‘SOP Type is equal to Order’. When used, this drill around would only display orders.

Drill Around Parameters

A parameter for a drill around is a column or columns that filter the records by a predefined field but not a
predefined value. Continuing the example above, if you wanted to further restrict the records for your drill
around to show only orders for the selected customer; you would also add the drill around parameter
‘Customer Number’. But rather than entering a search operator and value, you would mark the drill
around Parameter checkbox, identifying this column as a restriction that will be based on the selected
record.

To add selection criteria
Enter a name for the restriction as you would like it to appear in the Creator Goto parameter list.
Select the column to restrict.
Choose the drill around type by either marking the Drill Around Parameter checkbox, or selecting
a search operator and entering a search value.

& Select Criteria =10 =]

Select Critenia
Enter the Dl Around zearch criteria and zelect M et

I arne SOP Mumber Iv Diill &round Parameter
Colurmi SOP Murmber ™ Match Case
iz equal ko -
Clear |
| Add Criteria | Fiemaove Criteria | Femove Al |
Iv SOP Type =
i axirumn Records 1.000 Search Type Match &l -

< Back Memt > Cancel

Figure 21. The Select Criteria Window.
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Once you have entered the desired search criteria for this Drill Around, click NEXT >>.
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Select Columns

The select columns window allows you to define the display columns for the drill around. To use the
default column set from the object, mark the Leave Columns from (Default) favorite checkbox. To add,
remove or re-order the display columns, uncheck the Leave Columns from (Default) favorite checkbox

and make any desired changes.

i@ Select Columns

Select Columns

Select the columns for thiz Drill Around and select Nest.

=101 =]

™ ilze columnz from (O efault] favorite!

SOF Type
SOP Humber
[tern Murmber

[tern Description

I
b

LTy
Extended Cost il
Extended Price
IJnit Cozt - il
Add Femove Femove Al Drefault
<< Back et > Cancel |

Figure 22. The Select Columns Window.

Once you have chosen the desired columns for this Drill Around, click NEXT >>.
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Finish
After choosing the desired options for the drill around, name the drill around as you would like it to appear
in the AnyView Creator Goto lookup window.

_ o]
Create Dnll Around
Review and zave your selections.
M ame
Sales Line Items
<< Back Finizh Cancel

Figure 23. The Finish Window.

Once you have entered the name for this Drill Around, click FINISH >>.

Once the drill around has been created, it can be selected from the AnyView Creator wizard Goto lookup
list. When added to an object, the search criteria that you defined as drill around parameters will be
displayed in the Goto parameter list. Here you will map the search parameters to fields in the source
object.

Note: Any object, whether it is a default SmartList object, or one created using AnyView Creator, can be
the source object for a drill around. Only objects created with AnyView Creator, however, can have
these drill arounds added as a goto.
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Modify a Drill Around
After a drill around has been created, it's settings can be modified by selecting the Modify a Drill Around
action. All of the drill around’s properties can be modified, however, changing some properties will cause
the drill around to be removed from any object to which it was added as a goto. The changes that will
cause the goto to be removed are:

Modifying the existing criteria

Adding new criteria

Removing existing criteria

Note: After making any of these types of changes, you will need to re-add the selected drill around to any
objects for which it was originally assigned as a goto.

Delete a Drill Around
Choosing Delete a Drill Around will remove the selected drill around definition. Once deleted, this drill
around will no longer be available in the AnyView Creator Goto lookup window.

Note: Deleting a drill around that has previously been added to an object will automatically remove it from
any object to which it was added as a goto.
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SmartList Totals

SmartList Totals Goto

The SmartList Totals goto is an added feature of AnyView Creator. This goto is automatically added to all
default SmartList objects and all objects created with AnyView Creator. This feature allows you to view
totals for fields with a datatype of Long, Integer, and Currency. An example of the use of this functionality
would be a situation where you needed to see the total quantity and Extended Price of all items on
unposted Returns. By restricting the list in SmartList and using the SmartList Totals goto, you can display
these amounts.

~inixi
EICEE © [ O

Search Refresh Columns  Favorites Pritt Encel Ward Stop Go To

Sales Transaction Entry
Sales Transaction Inguiry Zoom

@ Customers = | Sales Line Items

§ Emplovess T Extended Cost Extended Price Unit Cost
. ’ P Y ! 4 Sales Grder Fulfillment
(- (3 Historical Serial Sales 1 21,25 $189,95 91,25 =alos Transfer D X
i ales Transfer Documents
@ Irventory Transactions é :igggg :Sgg?g $:gggg
@ Itemn Quantities c $29.90 $99.76 $5.98 Customer Maintenance

Custamer Inguiry
Customer Transackion Inguiry

@ Items

@ Mulkidirmensional Analysis

- (3 My Customers

; @ Payables Transactions
@ Payroll Historical Trx
@ Payroll Transactions

; @ Prospects

@ Purchase Ling Ikems
@ Purchase Orders

Customer Period Summary Inguiry
Customer Y¥early Summary Inguiry
Custamer Payment Summary Inguiry

Item Maintenance

Ikern Inguiry
Purchase Receipks Inquiry
Ikem Transaction Inquiry

Item Pricing Inguiry

@ Receivables Transactions
@ Sales Line Items

@ Sales Transactions
@ Test Acck

@ Test Data

(% TExt Field

@ Vendor Addresses

; @ Wendor Tkems

@ Vendars =i lI |

| 4 Sales Line Items

| Completed | First 1000 Sales Line ltems where SOP Type is equal to Return and Document Status is equal to Un EI

Figure 24. The SmartList Totals Goto.
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SmartList Totals

The SmartList totals window opens when selecting the SmartList Totals Goto from SmartList. This
window displays all of the display columns in the object that are of a datatype which can be totaled.

i@ Explorer Totals - Powered by Any¥iew

Calurnn

=10 x|

L UL

6 Ewtended Cost 393275000

7 Extended Price 1.849.41000

8 Unit Cast 434 63000

9 Unit Price 1,009.80000
Adust Totals v, 0K

Figure 25. The SmartList Totals Window.

Adjust Values by Row

The Adjust values by row window opens when clicking the Adjust Totals button from the SmartList Totals
Window. Here you can change the display of the totals. In the example above, you may want to display
the value of the Returns as a negative number. In this case, you could select the SOP Type field, enter
the conditional value ‘Return’ and choose ‘Force Negative’ If true. This will change the display of your

totals to show as negative.

Adjust values by row
SUF Typs is equalto | Retum

If true Force Megative - If falze Do Mathing

Vv 0K

° Cancel |

Figure 26. The Adjust values by row Window.
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External Tables Support

In conjunction with AnyView Creator, you can now create Views based on tables that are not part of your
Microsoft Dynamics™ GP solution, and view them with AnyView Browser. These tables can include any
additional SQL tables, Access database tables, and other ODBC compliant data sources.

For detailed documentation regarding External Tables Support in AnyView, refer to the AnyView Browser
documentation.

SQL Server objects in SmartList

When using AnyView Creator, objects that contain certain External Tables or SQL Views can be viewed
in the Microsoft Dynamics™ GP SmartList under some conditions.

For detailed documentation regarding External Tables Support in AnyView, refer to the External Tables
Support section in the AnyView Browser documentation.

Objects using External Tables will be available in Microsoft Dynamics™ GP SmartList ONLY IF the tables
or views are on the same SQL Server as the Microsoft Dynamics™ GP data and the “Microsoft
Dynamics™ GP SQL Server” option was specified as the Data Source in the second dialog of the
External Table Setup Wizard as shown below.

i Select Data Source Choose this

option to allow
Objects using
this External
Table Definition
to be shown in
C'ata Source Great Plains

(*)iGreat Plain: SOL Server ) Other ODBC Data Source et

Select Data Source

Enter data source information fo =trial tables and select Nest.

Arytiew Server Mame

[rata Source Mame

zer D — | Choose this
option if an
Rassvord identical table or
Database View exists in all
of the company
(%) Great Plain: Company Database ) Fized Databaze databases

[ratabasze Mame

’ <¢ Back ” Meut > l’ Cancel

Figure 27. Allow External Tables to be visible in Microsoft Dynamics™ GP SmartList.
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AnyView Object Auditor

The AnyView Object Auditor provides AnyView Administrators with the capability to audit AnyView
Objects and Favorites for missing fields or tables. This capability is particularly handy when upgrading
from one version of Microsoft Dynamics™ GP to another, or when applying a service pack. Version
upgrades and service packs may include changes to the Microsoft Dynamics™ GP dictionaries and
schemas in a way that will cause AnyView Obijects for fail. Examples include Favorites that search of
fields that no longer exist or Objects that reference tables that have been modified or removed from the

product.

AnyView Object Auditor is started from Utilities > System >AV Auditor.

=0l

Uze the Angtfiew Object Auditor to audit and repair Ariew objects.
Select one or more Anyiew objects to audit or repair, then process.

@ Audt ¢ Repair

Account Tranzactions Sample

To use the Auditor, select an action (AuDIT iecaunts Sample

Aryfiew External Loging

or REPAIR), select an Object or Objects to 24/ Receivables Tre [Open] Samole

A4 Sales Higtory

examine, then CIiCk PROCESS. A Salespeaple

Audit

Call Tracking
Customers Sample
Itemn Pricing
Partrers

Select All |
Select Mone |

Heports
ISéIes by Day

% Erocessl ° Cancel |

Figure 28. AnyView Object Auditor.

The Audit option will report on the following problems with AnyView object definitions:

O
O
O
O

Incorrect Resource ID data for object tables.
Incorrect Resource ID data for object columns.
Object tables that do not exist in the schema.
Object columns that do not exist in the schema.

The Audit Report will recommend:

O
O
O

Repair

Repair option in Auditor for incorrect resource IDs.
Deleting object for tables that do not exist in schema.

Deleting column in Creator for columns that do not exist in schema.

The Repair option will fix:

O
O

ANYVIEW

Incorrect Resource ID data for tables.
Incorrect Resource ID data for columns.
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If you have AnyView objects that contain external tables that are not in the Microsoft Dynamics™ GP data
source, make sure that the data sources are accessible to the workstation that is performing the audit.
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